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概要 放送映像の分野では、 ビデオの制作、 中継、 配信、 消費の各部門でさまざまなフォーマッ トのビデオ コ
ンテンツが混在しています。 これらのコンテンツを正し くアーカイブ、 配信、 表示するには、 多くの場

合、目的に応じたフォーマッ ト変換を実行してビデオ信号を適切に処理する必要があ り ます。たとえば、

NTSC/PAL 信号を FHD LCD 画面に正し く表示するには、 デインターレース、 スケーリ ング、 ク ロマ

アップサンプリ ング、色補正といった一連の処理に加え、 アルファ  ブレンディングも実行する必要があ

り ます。

このアプ リ ケーシ ョ ン ノートでは、 マルチス ト リーム/マルチパイプラインのビデオ処理ニーズに対応

した真にスケーラブルなビデオ プロセッサを、 最新のザイ リ ンクス  Kintex™-7 FPGA アーキテクチャ

に実装した リ ファレンス  デザインを紹介します。この リ ファレンス  デザインは、マルチビューアー ディ

スプレイ、 ビデオ スイ ッチ、 マルチチャネル ビデオ ルーター、 マルチス ト リーム アップ/ダウン コン

バーターなどのアプリ ケーシ ョ ンを対象にしています。

はじめに こ こで紹介する放送品質のビデオ処理リ ファレンス  デザインは、幅広いビデオ アプリ ケーシ ョ ンをター

ゲッ ト と しています。 リ アルタイム ビデオ エンジン 2.0 (RTVE 2.0) リ ファレンス  デザインの中心とな

る機能はビデオのデインターレースと スケーリ ングですが、それ以外にも ト リプルレート  SDI インター

フェイス、 DVI インターフェイス、 オンスク リーン ディ スプレイ  (OSD)、 ビデオ フレームバッファー

制御、 クロマ リサンプリ ング、色空間変換などを備えています。 このデザインのビデオ処理機能は拡張

可能で、 2x、 4x、 8x の並列ビデオ パイプラインをサポート します。

RTVE 2.0 には次の特長があ り ます。

• HDMI と ト リプルレート  SDI のビデオ ソースをオンザフライで切り換え可能

• プログレッシブまたはインターレース  ビデオ フォーマッ ト をサポート

• 複数のビデオ出力ポート  : HD/3G-SDI および HDMI

• 複数の FPGA に最適化されたスケーラブルなデザイン

• 2 パイプライン - XC7K160T のロジッ ク集積度に対応

• 4 パイプライン - XC7K160T のロジッ ク集積度に対応

• 最大 8 パイプライン - XC7K325T のロジッ ク集積度に対応

• 完全にザイ リ ンクスの AXI インフラス ト ラ クチャ  ベース

• AXI-Lite CPU 制御インターフェイス

• 外部メモ リ  アクセスには AXI メモ リ  マップを使用

• ビデオ処理ブロ ッ ク間のビデオ ス ト リーミ ングには AXI ス ト リーミ ングを使用

• 各パイプラインで完全なビデオ処理機能を実行 

• 動き適応型およびエッジ適応型のデインターレーサー 

• オンザフライでカスタマイズ可能な係数テーブルを使用するポ リ フェーズ スケーラー

• 10 ビッ ト  4:4:4 処理エンジン

• フレーム バッファー リードバッ ク
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• オンザフライでのウ ィンド ウ  サイズ変更と拡大鏡機能

• ビデオ出力にグラフ ィ ッ ク  オーバーレイを合成

• ライブ ビデオのピクチャ  イン ピクチャ

• 業務用品質のフェード イン/フェードアウ ト効果

• 色補正マ ト リ ッ クスによるコン ト ラス ト調整

• ウェブ サーバー ベースの制御 GUI

RTVE 2.0 FPGA 
デザイン

RTVE 2.0 デザインの中心となるビデオ処理エンジンは、 OmniTek 社が開発した最先端のスケーラブル

ビデオ プロセッサ (OSVP) [参照 1] がベースになっています (図 1)。 OSVP には、 x2、 x4、 x8 の並列

処理をサポートする設定変更可能なビデオ パイプラインが内蔵されています。各パイプラインは、 ク ロ

マ アップサンプリ ング、 色空間変換、 デインターレース、 ク ロ ッピング、 スケーリ ング/ リサイジング、

ビデオ出力フレーム同期の処理で構成されます。また、各 OSVP にはすべてのビデオ処理ブロッ クから

のあらゆる外部メモ リ  アクセス要求に対して円滑化、バランス調整、アービ ト レーシ ョ ンを実行するマ

ルチポート  ビデオ DMA ブロ ッ クが、 処理パイプラインの数に応じて 1 つまたは 2 つ含まれます。

OSVP はザイ リ ンクスの AXI4 ペリ フェラル バス  テク ノ ロジを完全に採用しています。 制御プレーン

は AXI4-Lite インターフェイスからコマンドを受け取り、外部メモ リへは 1 つまたは 2 つの AXI4-MM
インターフェイス経由でアクセスします。 また、 ビデオ入出力には AXI4 ス ト リーミ ング インターフェ

イスを使用します。 これらによ り、 ザイ リ ンクスのデザイン環境およびメ ソ ド ロジとの高い互換性を実

現しています。

 

AXI4 インフラス ト ラ クチャを利用した OSVP は、 ビデオ ス ト リーミ ング入力/出力、 MicroBlaze™ ソ
フ ト  プロセッサ、 On-Screen Display (OSD) LogiCORE™、 Video Time Controller (VTC) LogiCore、
AXI インターコネク ト、 AXI DDR などのザイ リ ンクス  IP 構築ブロ ッ ク と容易に統合してフル機能の

リ アルタイム ビデオ エンジンを構成できます。 図 2 に、 このデザインのアーキテクチャを示します。

X-Ref Target - Figure 1

図 1 : OSVP (OmniTek Scalable Video Processor)
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ビデオ入力

RTVE 2.0 は最大 8 つの SDI 入力ソース と  1 つの HDMI 入力ソースをサポート しています。 サポート

される入力フォーマッ トは次のとおりです。

• SDI : SD-NTSC、 SD-PAL、 HD-1080i、 HD-1080p、 HD-720p

• HDMI : 480p、 576p、 720p、 1080i、 1080p

ビデオ出力

RTVE v2.0 はすべてのインターフェイス  (HDMI と  SDI) でビデオ出力を同時に生成します。出力フォー

マッ トは、 720p50、 720p60、 1080p50、 1080p60 レート のいずれかをユーザーが選択できます。 出力

フレーム レートは、 入力フレーム レート を元にして得られ、 フレーム リ ピート またはフレーム ド ロ ッ

プのいずれかと一致します。 たとえば、 480i 59.94Hz の入力にデインターレースと スケーリ ングを実行

して 720p60 または 1080p60 を出力する場合はフレーム リ ピートが実行されます。同様に、出力フォー

マッ ト を 720p50 または 1080p50 に設定する と、 適切にフレーム ド ロ ップが実行されます。

ビデオ処理

主なビデオ処理機能ブロッ クは次のとおりです。

• ク ロマ アップサンプリ ング : 最大限高品質の画質を得るため、 OSVP はス ト レート な 4:4:4 の 10
ビッ ト処理パイプラインを実行します。 4:2:2 の入力ビデオ ス ト リームは、 最初に 4:4:4 ス ト リー

ムにアップサンプリ ングします。

• 色空間変換 : OSVP では、 幅広い種類の色空間を変換できます。

• デインターレース  : OSVP は、 動き適応型およびエッジ適応型の手法を用いてインターレース方式

の入力ビデオを等価なプログレッシブ方式のビデオ フォーマッ トに変換します。 また、OSVP には

映画コンテンツに対して 2:2 および 3:2 プルダウンなどのケイデンスを検出する機能もあ り ます。

その後、 OSVP はビデオを補正して元のフォーマッ トで再構築します。

X-Ref Target - Figure 2

図 2 : RTVE 2.0 デザインのブロック図
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• ク ロ ッピング : OSVP では、 入力ビデオの特定の領域のみを指定して以降の処理を実行できます。

この処理は、 たとえば映画と広告など 1 つのビデオ ス ト リームに 4:3 と  16:9 の異なるアスペク ト

比が混在する場合の切り換えに使用されます。

• スケーリ ング/ リサイジング : OSVP では、 スケーリ ング/ リサイズ ブロ ッ クがデインターレース  ブ
ロ ッ クから出力されたプログレ ッシブ方式のイ メージのサイズを別の出力サイズへ変更します。

アップスケーリ ング、 ダウンスケーリ ング、 ズーミ ング、 アスペク ト比調整など、 さまざまな入出

力スケーリ ング操作をユーザーが選択できます。

• OSD : OSVP の出力は OSD に入力され、 ビデオ、 グラフ ィ ッ クス、 テキス ト  オーバーレイを含め

たスケーリ ング済みの最終イ メージが出力ビデオ ス ト リームにレンダ リ ングされます。 OSD ブ
ロ ッ クでは、 最大 8 つのビデオ ス ト リームを重ねて表示できます。

各ビデオ処理機能ブロッ クの詳細は、 『OSVP ユーザー ガイ ド』 [参照 1] を参照してください。

外部メモリ使用率の解析

真にスケーラブルなビデオ プロセッサを実装するには、 メ モ リ 使用率を改善する こ とが重要です。

OSVP では、 各ビデオ処理パイプラインに同時アクセス可能な 5 つのメモ リ  ポートがあ り ます。 内訳

は、 デインターレース  ブロ ッ クに 2 つの読み出しポート と  1 つの書き込みポート、 リサイズ ブロ ッ ク

に 1 つの書き込みポート、 OSD に 1 つの読み出しポートです。 8 パイプライン構成の場合、 最大 40 の
同時アクセス可能なメモ リ  ポートが必要です。 実際のメモ リ使用率はデザインによって異なり ます。

こ こでは、 4:4:4 インターレース  ビデオ、 30 ビッ ト  カラー、 75 x 106 ピクセル/秒のレートの条件でビ

デオ ウ ィンド ウすべてを重ね合わせず 1 つの画面に表示した場合のメモリ使用率を、パイプライン構成

ごとに解析します。 表 1 に、 メモ リ使用率を示します。

このビデオ フォーマッ トでは、 デインターレース  ブロ ッ クの各読み出し /書き込みポートにおける最大

データ  フローは、 動きベクターのオーバーヘッ ドを含めて 40 x 75 = 3,000Mb/s です。 デインターレー

ス  ブロ ッ クの出力は、 直接 OSVP のリサイズ ブロ ッ クの入力へ送られます。 各パイプラインで処理し

たビデオは重ね合わせずに 1 つの画面に表示されるため、すべてのパイプラインのリサイズ ブロ ッ クの

書き込みポート のデータ  フローは合計で 30 x 150 = 4,500Mb/s とな り ます。 OSD 読み出しポート の

データ  フロー合計も同じ値となり ます。

これらの値を合計する と絶対最大データ  フローが得られますが、OSVP はアクティブなイ メージにのみ

データ処理を限定し、任意のラインの処理結果を走査線 1 ライン分全体に適用するこ とで必要な帯域幅

を抑える仕組みを採用しています。 これによ り、必要な最大データ  フローは実際のライン長とアクティ

ブなライン長の差分に応じて少なくな り ます。 こ こに示した例では、 計算上の合計に 0.93091 を掛けた

値が平均最大データ  フローとなり ます。

x2 および x4 の構成では、 DDR3 64 ビッ ト  800Mb/s のメモ リで十分対応できます。 x8 構成の場合、ザ

イ リ ンクス  Kintex-7 FPGA の優れたパフォーマンスを十分に活かすには DDR3 64 ビッ ト  1,600Mb/s
が必要です。

表 1 : RTVE 2.0 のメモリ使用率の内訳

2 パイプライン OSVP 4 パイプライン OSVP 8 パイプライン OSVP

デイ ン ターレース

ブロ ッ ク

(3,000 x 3) x 2 = 18,000Mb/s (3,000 x 3) x 4 = 36,000Mb/s (3,000 x 3) x 8 = 72,000Mb/s

リサイズ ブロッ ク 4500Mb/s 4500Mb/s 4500Mb/s

OSD 4500Mb/s 4500Mb/s 4500Mb/s

合計 27000Mb/s 45000Mb/s 81000Mb/s

平均 25134.6Mb/s 41891Mb/s 75403.6Mb/s
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RTVE 2.0 プロ
ジェク トの作成

次に、 x4 OSVP 構成の RTVE 2.0 デザインの作成手順を、 実際の例を挙げて説明します。

プロジェク トのディ レク ト リ構造

図 3 に、 RTVE 2.0 プロジェク トのディ レク ト リ構造を示します。

 

ツール

このプロジェク トは完全なザイ リ ンクス  EDK フローに基づいてインプ リ メ ン ト されているため、 ISE
Design Suite 14.4 Embedded Edition 以降を使用する必要があ り ます。 最初に、 EDK を用いてハード

ウェアを作成します。次に、SDK プロジェク ト を作成して FPGA BIT ファ イルと  MicroBlaze プロセッ

サ ソフ ト ウェアを KC705 開発システムに展開します。

EDK ハードウェアの作成

EDK ハードウェアを作成するには、 次の手順に従います。

1. XPS (Xilinx Platform Studio) を起動します。

2. release\rtve_2_0_kc705_4x_hw ディ レク ト リにある  rtve_2_0_kc705_4x.xmp プロジェ

ク ト  ファ イルを選択してロード します (図 3)。 システム ビューに似た EDK 画面が表示されます

(図 4)。 この画面には、 RTVE 2.0 で使用している各種 pcore の接続情報もすべて表示されます。

X-Ref Target - Figure 3

図 3 : RTVE 2.0 プロジェク トのディ レク ト リ構造
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3. メニュー バーで [Device Configuration] → [Update Bitstream] をク リ ッ ク します。

これで release\rtve_2_0_kc705_4x_hw\implementation\ ディ レ ク ト リ に FPGA ビ ッ ト

ス ト リーム rtve_2_0_kc705_4x.bit が作成され、 ビッ ト ス ト リームが MicroBlaze プロセッサ ブー

ト ス ト ラ ップ バイナリ  コードで更新されます。

更新されたビッ ト ス ト リームは、 新しいファイル名 download.bit と して保存されます。

SDK ソフ トウェアの作成

RTVE 2.0 ソフ ト ウェアはローカルの SDK ワークスペース内にあ り、RTVE 2.0 固有のド ライバーはす

べて RTVE 2.0 プロジェ ク トの階層内に含まれます。 ザイ リ ンクスのビル ト イン ド ラ イバーはすべて

SDK によって自動的に検出されます。

SDK ソフ ト ウェアを作成するには、 次の手順に従います。

1. RTVE 2.0 の階層の固定ディレク ト リ  レベルに新規ユーザー ワークスペースを作成するには、

[File] → [Switch Workspace] → [Other] をク リ ッ ク します。

プロジェク トの最上位ディ レク ト リからの相対パスと して指定されたデフォルトのディ レク ト リに

ファ イルがエクスポート されます。

2. ダイアログ ボッ クスで、 ディ レク ト リのパス名の最後が SDK ディ レク ト リ  
(release\rtve_2_0_kc705_4x_sw\sw\SDK_Workspace) となっているこ とを確認します 
(図 5)。

X-Ref Target - Figure 4

図 4 : XPS での RTVE 2.0 の作成
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3. インポート  プロセスが完了したらすぐに自動作成プロセスによってすべてのド ライバーが検出さ

れるよ うに、プロジェク ト をインポートする前に RTVE 2.0 プロジェク トのローカル ド ラ イバー リ
ポジ ト リ を追加しておきます。

a. [Xilinx Tools] → [Repositories] をク リ ッ ク します。

b. [Local Repositories - (available to the current workspace)] で [New] をク リ ッ ク して 
…\repository ディレク ト リ を選択します。

c. [OK] をク リ ッ ク して新しいローカル ド ラ イバー リ ポジ ト リ を決定します。

リポジ ト リ を追加する と、 図 6 のよ うに表示されます。

 

4. SDK で RTVE リ ファレンス  ソフ ト ウェアを作成する際の元となる定義済みのソフ ト ウェアおよび

ハードウェア プロジェク ト をインポートするには、 [File] → [Import] をク リ ッ ク します。

X-Ref Target - Figure 5

図 5 : RTVE 2.0 SDK ワークスペースのセッ トアップ

X-Ref Target - Figure 6

図 6 : RTVE 2.0 SDK リポジト リのセッ トアップ
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5. [Import] ダイアログ ボッ クスで [General] → [Existing Projects into Workspace] をク リ ッ ク し、

[Next] をク リ ッ ク します (図 7)。
 

6. [Import Projects] で [Select root directory] をオンにし、 [Browse] をク リ ッ ク して 
release\rtve_2_0_kc705_4x_sw\sw ディ レク ト リ を指定します。

7. SDK が 3 つのプロジェク ト を検出し、 自動的にすべてをインポート対象と して選択します (図 8)。
[Finish] をク リ ッ クする と  3 つのプロジェク トがインポート されます。

X-Ref Target - Figure 7

図 7 : RTVE の SDK ワークスペースにインポート

X1091_07_031213
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これで、 SDK はすべてのド ライバーを検出してソフ ト ウェアを作成します。

8. 正し く作成される と、 release\rtve_2_0_kc705_4x_sw\sw\SDK_Workspace\Debug ディ レ

ク ト リに MicroBlaze ソフ ト ウェア rtve_kc705.elf が生成されます。

表 2 に、 この リ ファレンス  デザインの詳細を示します。

X-Ref Target - Figure 8

図 8 : RTVE 2.0 ソフ トウェアの 3 つのプロジェク ト をすべてインポート

表 2 : デザインの詳細

パラメーター 説明

シミ ュレーシ ョ ン

機能シ ミ ュレーシ ョ ンの実施 実施済み

タイ ミ ング シ ミ ュレーシ ョ ン 未実施

機能およびタイ ミ ング シ ミ ュレーシ ョ ンでのテス トベ

ンチの利用

機能シ ミ ュレーシ ョ ンのみ

テス トベンチの形式 VHDL

使用したシ ミ ュレータ  ソフ ト ウェア/バージ ョ ン Modelsim / 6.6d

SPICE/IBIS シ ミ ュレーシ ョ ン NA

X1091_08_031213
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表 3 に、 RTVE 2.0 のリ ソース使用状況の内訳を示します。

デモのセッ トアップ こ こでは、 4x 構成のデモをセッ ト アップする手順と して、 ハード ウェア セッ ト アップと ソフ ト ウェア

セッ ト アップについて説明します。 ソフ ト ウェアを FPGA にロードするために必要な次のファイルは、

プロジェク ト  ファ イルに含まれています。

• 生成済み FPGA ビッ ト ス ト リーム : kc705_4x.bit

• コンパイル済み MicroBlaze ファームウェア バイナリ  : kc705_rtve_4x.elf

インプリ メンテーシ ョ ン

使用した合成ソフ ト ウェア ツール/バージ ョ ン ISE 14.4

使用したインプ リ メンテーシ ョ ン ソフ ト ウェア ツール/
バージ ョ ン

ISE 14.4

スタティ ッ ク  タイ ミ ング解析の実施 実施済み

ハードウェア検証

ハードウェア検証の実施 実施済み

検証に使用したハード ウェア プラ ッ ト フォーム KINTEX-7 KC705 ボード、

TED TB-TB-FMCH-3GSDI2A カード、

TB-FMCL-HDMI カード

表 3 : リソース使用状況

BRAM/FIFO 

36 ビッ ト
FF LUT DSP

OSVP コア

OSVP2 (2 入力チャネル) 108 22240 18412 102

OSVP4 (4 入力チャネル) 192 41398 34623 204

OSVP8 (8 入力チャネル) 379 80500 69406 408

サポート  IP

SDI 入力 (1 入力チャネルあたり ) 0 1,900 2,500 0

SDI 出力 0 409 445 0

HDMI 入力 0 405 287 0

HDMI 出力 0 79 53 0

AXI インターコネク ト  : CPU ペリ フェラル 0 2,000 1,091 0

AXI インターコネク ト  : 広帯域 0 12,231 8,056

On-Screen Display (4 チャネル) 2 5,093 2,983 12

MicroBlaze 19 3,168 7,850 6

DDR3 MIG (4 ～ 8 チャネルをサポート ) 0 17,891 15,511 0

Video Timing Controller 0 764 757 0

合計

2 入力 RTVE 2.0 149 83,695 73,937 183

4 入力 RTVE 243 105,801 96,547 291

Kintex 7 160T リ ソース 325 202,800 101,400 600

8 入力 RTVE 415 158,013 136,767 504

Kintex 7 325T リ ソース 445 407,600 203,800 840

表 2 : デザインの詳細 (続き)

パラメーター 説明

http://japan.xilinx.com
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• イ メージ ファ イル : image.mfs

• FPGA コンフ ィギュレーシ ョ ン スク リプ ト  : start_kc_4x.tcl

ハードウェア

このデモに必要なハード ウェアは次のとおりです。

• ザイ リ ンクス  KC705 評価ボード  XC7K325T-2FFG900 FPGA (x1)

• TED TB-FMCH-3GSDI2A カード  (x1)

• TED HDMI 1.3 Rev 3 (TB-FMCL-HDMI) FMC カード  (HDMI 入出力用。 x1) 

• 720p@60Hz (1280x720 p@60) 以上をサポート した HDMI モニター (x1)

• SD/HD/3G SDI ビデオ ソース  (x4)

• HDMI ビデオ ソース  (オプシ ョ ン。 x1)

• HDMI ケーブル (x1)

• ミ ニ DIN SDI ケーブル (x4)

• WiFi イーサネッ ト  ルーター (DHCP サーバーと して。 x1)

• イーサネッ ト  ケーブル (x1)

• マイクロ  USB ケーブル (FPGA コンフ ィギュレーシ ョ ン用。 x1)

• ミ ニ USB ケーブル (UART デバッグ用。 オプシ ョ ン。 x1)

• 空き  USB ポートが 2 つ以上ある  PC (x1)

ハードウェアのセッ トアップ

図 9 に、 ハード ウェアのセッ ト アップを示します。 TED TB-FMCH-3GSDI2A カードを KC705 評価

ボードの HPC (High Pin Count) FMC コネクタに接続します。TED TB-FMCL-HDMI カードを KC705
評価ボードの LPC FMC コネクタに接続します。

http://japan.xilinx.com
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図 10 に、配線を含めたデモのセッ ト アップを示します。TED TB-FMCH-3GSDI2A カードの CH0-RX、

CH1-RX、 CH2、 CH3 コネクタに、 ミニ DIN SDI ケーブルを用いて 4 つの SDI ビデオ ソースを接続し

ます。 TB-FMCL-HDMI カードを使用する場合は、 カードの RX ポートに HDMI ソースを接続します。

X-Ref Target - Figure 9

図 9 : KC705 RTVE 2.0 デモのセッ トアップ

HDMI Video Source

Xilinx KC705 Board +
TED HDMI FMC +
TED SDI 2A

Control PC
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Wireless
Router

SDI Video Input
Coming From

SDI Video Source
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ビデオ出力は HDMI または SDI モニターに表示できます。HDMI 出力は TB-FMCL-HDMI TX ポート

から駆動されます。SDI 出力は TB-FMCH-3GSDI2A カードの CH0-TX および CH1-TX コネクタから

駆動されます。 どちらの出力も、 ミ ニ DIN ケーブルを使用します。

RTVE 2.0 に IP アドレスを割り当てるために、 KC705 のイーサネッ ト  ポート を無線ルーターの LAN 
ポートに接続する必要があ り ます。 必要なハードウェアを同梱した Kintex-7 FPGA 放送用ビデオ キッ

トは、 ザイ リ ンクス  エコシステム パートナーの Inrevium 社のウェブサイ ト  [参照 3] で 
TB-7K-325T-BVK-RTVE と して販売されています。

ソフ トウェア

• Microsoft Windows 7/XP/Vista

• ザイ リ ンクス  ISE 14.4 以降のパッケージ (必要なすべての KC705 デバイス  ド ラ イバーを含む)

FPGA コンフ ィギュレーシ ョ ン

KC705 ボードの Kintex-7 FPGA をコンフ ィギュレーシ ョ ンするには、 制御用 PC と  KC705 のマイ ク

ロ  USB ポート をマイ クロ  USB ケーブルで接続し  (図 10)、 次の手順に従います。

1. Xilinx Microprocessor Debugger (XMD) ツールを起動します。

X-Ref Target - Figure 10

図 10 : RTVE 2.0 デザインのブロック図

X1091_10_031213
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2. 作成済み FPGA ビッ ト ス ト リーム download.bit、 MicroBlaze ソフ ト ウェア 
kc705_rtve.elf、 イ メージ ファ イル image.mfs、 FPGA コンフ ィギュレーシ ョ ン スク リプ ト  
start_kc_4x.tcl が保存されているディ レク ト リ  release\ready_for_download へ移動し

ます。

3. source start_kc_4x.tcl を実行して FPGA をコンフ ィギュレーシ ョ ンします。

RTVE 2.0 のウェブ ベースの制御 GUI 

RTVE 2.0 は、 IP アドレスを指定してウェブ ベースの GUI にアクセスして制御します。 このアドレス

は、出力画面の右上にあるシステム ステータス  ボッ クスに表示されます (図 11)。 このステータス  ボッ

クスには、 入出力フォーマッ トに関する情報もすべて表示されます。

 

RTVE 2.0 の制御 GUI (図 12) を開くには、 ウェブ ブラウザーを起動してアドレス  バーに IP アドレス

を入力し、 Enter キーを押します。

X-Ref Target - Figure 11

図 11 : [System Status] テキスト  オーバーレイ ボックス

X1091_11_031213
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制御 GUI の左側には、ビデオ ソース、デインターレース  モード、スケーリ ング サイズ、OSD アルファ

ブレンディングの透明度など、 各ビデオ処理パイプラインで設定可能な項目が表示されます。 右側では

ビデオ出力画面の設定を行います。出力フォーマッ トは、オプシ ョ ン ボタンをク リ ッ ク して変更できま

す。

X-Ref Target - Figure 12

図 12 : RTVE 2.0 のウェブ ベース制御 GUI

X1091_12_031213
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初期状態では、画面右下に 4 分割レイアウ トが表示されています。 [Next Layout] をク リ ッ クする と、あ

らかじめセッ ト されたレイアウ トが順番に切り換わり ます。 4 つのビデオ ウ ィンド ウのサイズは、 それ

ぞれウ ィンド ウの境界または隅をク リ ッ ク したまま ド ラ ッグして変更可能です。

ウ ィ ン ド ウ内の任意の場所をク リ ッ ク したまま ド ラ ッグする と、 出力画面の自由な位置へ移動できま

す。複数のウ ィンド ウを重ねて表示するこ と も可能です。 さ らに、各ウ ィンド ウのアルファ  ブレンディ

ングの透明度を変更する と、 ピクチャ  イン ピクチャの機能を実現できます。 また、 RTVE 2.0 では、最

大 8 つのウ ィン ド ウを重ねて表示でき、 透明度を個別に制御してフェード イン/フェードアウ トの効果

を得るこ とができます。

GUI ソフ ト ウェアの右上部にある  [Snapshot Scaler] をク リ ッ クする と、 各パイプラインでの処理を経

た リサイズ ブロ ッ クのビデオ出力をキャプチャできます。

デモおよびベンチマーク  テスト時の推奨事項

RTVE の中核となる  2 つの処理ブロッ ク  (デインターレース とスケーリ ング) を効果的に利用するには、

十分な対角線、 動き、 ク ロマ カラー バース ト、 フ ィルム モード  ケイデンスなど、 難易度の高い各種

シーケンスを含む業務用のビデオ ベンチマーク  ツールを使用するこ とを推奨します。

NTSC/PAL のインターレース  ビデオを HDMI/DVI インターフェイス経由で送信する と規格上の制約を

受けるため、 デインターレースおよびスケーリ ングのベンチマーク  テス ト を実行する場合は SDI イン

ターフェイスの使用を推奨します。 ビデオ コンテンツは業務用ビデオ サーバーのネイティブ SDI イン

ターフェイスから送信する以外にも、 通常の DVD プレーヤーから  HDMI/DVI-to-SDI コンバーターを

経由して送信できます。 ビデオ インターフェイス  コンバーターの製品例は、

http://www.blackmagic-design.com/products/dviextender/ を参照してください。

デザイン アドバイ
ザリ

こ こでは、 RTVE デモのデザイン アドバイザリについて説明します。

• HDMI RX ビデオ モード  : TB-FMCL-HDMI カードの HDMI RX ポートでは、 NTSC/PAL ビデオ

の受信はサポート されません。 この制約に関連して、 次の 2 点に注意が必要です。

• HDMI 仕様では、NTSC/PAL のサポートは必須ではあり ません。したがって、NTSC/PAL フォー

マッ トの送信機能を実装するかど うかは個々のメディア プレーヤーに依存します。

• 『TB-FMCL-HDMI Hardware User Manual』 [参照 2] では、NTSC/PAL はサポート されていま

せん。

• 2:2 フ ィルム モードのケイデンス検出 : メディア コンテンツとプレーヤーによっては、 2:2 ケイデ

ンスを検出できないこ とがあ り ます。

参考資料 1. OmniTek Scalable Video Processor (OSVP) User Guide

http://omnitek.tv/sites/default/files/OSVP.pdf

2. TB-FMCL-HDMI Hardware User Manual

http://solutions.inrevium.com/products/pdf/pdf_TB-FMCL-HDMI_HWUserManual_3.00e.pdf

3. Kintex-7 FPGA Broadcast Video Kit

http://solutions.inrevium.com/products/kits/broadcast/tb-7k-325t-bvk.html

改訂履歴 次の表に、 この文書の改訂履歴を示します。

日付 バージョ ン 内容

2013 年 4 月 5 日 1.0 初版
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Notice of 
Disclaimer

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use
of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available
"AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS,
EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE;
and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other
theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection
with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss
or damage suffered as a result of any action brought by a third party) even if such damage or loss was
reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no
obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or
to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of the Limited
Warranties which can be viewed at http://www.xilinx.com/warranty.htm; IP cores may be subject to
warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not
designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you
assume sole risk and liability for use of Xilinx products in Critical Applications: 
http://www.xilinx.com/warranty.htm#critapps.

本資料は英語版 (v1.0) を翻訳したもので、 内容に相違が生じる場合には原文を優先します。

資料によっては英語版の更新に対応していないものがあ り ます。

日本語版は参考用と してご使用の上、 最新情報につきましては、 必ず最新英語版をご参照ください。

この資料に関するフ ィードバッ クおよびリ ンクなどの問題につきましては、

jpn_trans_feedback@xilinx.com までお知らせください。 いただきましたご意見を参考に早急に対応さ

せていただきます。 なお、 このメール アドレスへのお問い合わせは受け付けており ません。 あらかじめ

ご了承ください。
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